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Warranty

Qdea warrants that any original purchased disk on which this software is
received is free from defects in material and workmanship, under normal use, for
90 days after the date of original purchase. If a defect occurs during the 90-day
period, you may return the disk to Qdea for a free replacement.

The remedy for breach of this warranty shall be limited to replacement and shall
not encompass any other damages, including but not limited to loss of profit, and
special, incidental, or other claims. The software is licensed and delivered on an
“as is” basis. Except for the express warranty set forth above, Qdea makes no
other warranties, either express or implied, by statute or otherwise, regarding the
enclosed computer software product, or its fitness for any particular purpose.

Software License

Each copy of Synchronize! X Plus is licensed for installation on one computer. A
single copy of Synchronize! X Plus may be installed on a second computer at a
different location for the purposes of synchronizing the information between the
two computers, with the restriction that the software may not be in use on both
computers at the same time. Installing Synchronize! X Plus on more than one
computer at the same location requires the purchase of one Synchronize! X Plus
license for each computer.
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Introduction

Synchronize! X Plus is general-purpose utility for personal file synchronization
and backup. Its uses include keeping a copy of your personal data up-to-date on
more than one computer and backing up your personal data to an external disk.

File Synchronization

Synchronize! X Plus solves the problem of changing your documents on more
than one computer.

You’re familiar with the problem: you have a Mac at work and a PowerBook or a
Mac home, and you have some changes that you need to make in a few of your
documents. So you copy them onto your PowerBook or a ZIP disk, take them
with you, and change them. When you’re done with the changes, you replace the
older documents on your Mac at work with the newer ones.

Synchronize! X Plus automates the process of keeping the most recent version of
any number of documents on multiple Macs that you use, so that you don’t have
to worry about it.

Synchronize! X Plus will keep two folders on different Macs synchronized, and
always copy the newest document in a folder to the corresponding folder on a
PowerBook, another Mac, or on a disk you take with you.

Backup, quick and easy

Synchronize! X Plus makes backups much more efficient by copying only files
that have changed. The first backup will still take a while, although it will be
done as quickly as possible, due to the high-performance architecture of
Synchronize! X Plus. Subsequent backups take much less time, because only files
that have changed are copied again. This can speed up a backup by 90% or more.

Using Synchronize! X Plus with disks on the desktop

Synchronize! X Plus works with any disk that appears on the desktop, whether it
is a removable disk, hard disk, or file server volume. The disk might be a
PowerBook in “FireWire Target Mode”, an AppleShare file server or a Mac with
File Sharing, an NFS disk, or a WebDAV server.

Once the disk appears on your desktop, choose any two folders for the
synchronization. Once you set it up, Synchronize! X Plus will copy any newer
files between two folders on any disk, automatically.

Synchronizing remotely with removable disks

Macs in two different locations can be synchronized by carrying a removable
disk between them. Firewire disks are well-suited to this purpose because they
are small, portable, and many don’t require external power.
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The idea is to synchronize a folder on each Mac with a folder on the removable
disk. Synchronize! X Plus copies only the documents which are newer from the
hard disk to the removable disk, so it takes less time.

As you move from one Mac to the other, use Synchronize! X Plus to copy any
newer documents to your portable disk. At the other Mac, use it again to copy
those documents to the hard disk.

All you have to do to keep the newest versions of your documents on both Macs
is to use Synchronize! X Plus when you leave one Mac, and when you arrive at
the other Mac. Your removable disk is also a backup of your most recent files.
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Getting Started

Installation

Installing Synchronize! X Plus is usually done with an installer. The installer may
be on a CD or it may be downloaded from the Qdea web site at
http://www.qdea.com      .

To install Synchronize! X Plus double-click the installer and follow the directions.
Unless you direct otherwise, the software is installed in your Applications folder.

Try an example

The best way to learn about Synchronize! X Plus is to try it out. Here’s a simple
example:

1. Think of a folder that you’d like to backup or synchronize.

2. Open Synchronize! X Plus.

3. To set the folders to be synced, click on each folder, navigate to the
folder you want to sync and click Choose.

4. Click the Sync… button. Synchronize! X Plus shows the documents
which will be copied.

5. Click the Start button. Synchronize! X Plus copies the documents
from one folder to the other.

Note: Just like a word processor or a spreadsheet, Synchronize! X Plus
uses the contents of its setup documents to tell it what to do. In the case
of Synchronize! X Plus, its documents tell it what folders to synchronize,
and what options have been set.

If you click the “Sync” button again, Synchronize! X Plus reports that “The two
folders are the same”. This is because Synchronize! X Plus has copied all files
which are different to the other folder, making the folders identical. Because
Synchronize! X Plus copies files only when they are different, it has no more files
to copy.
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Using Synchronize! X Plus

This chapter discusses how Synchronize! X Plus works. It describes one way
Synchronize! X Plus can work for you.

The problem

The primary purpose of Synchronize! X Plus is to keep the most recent versions
of your documents on more than one disk.

This is best illustrated by two documents, A and B. For the purposes of this
example, Document A is on your Mac at work, and Document B is on your Mac
at home.

Document A is initially the same as Document B. While at wok, you make some
changes to Document A. At home, an inspiration hits you, and you make some
changes to Document B.

You put Document B on a floppy disk, intending to update your Mac at work.
But wait! If you copy Document B onto your hard disk at work, the changes you
made to Document A will be lost!

Naturally, if you only worked with one document, you’d remember where you
made the last change. But it you hadn’t changed it in a while, it might be hard to
remember which location has the most current version of a document.

The solution

Wouldn’t it be nice if there were a way to automatically keep both locations’
documents up-to-date, so that any changes are always made to the most recent
version?

That’s what Synchronize! X Plus does for you, automatically.

Using Synchronize! X Plus with removable disks

To let Synchronize! X Plus solve this problem for you, create a folder on your
Mac at work. Call it “Working Documents”. This folder contains your working
documents, which are those documents you’re changing regularly.

Arrange the organization of your files so that your “Working Documents” folder
contains the files you’re working on. The contents of this folder should be
smaller than the size of the removable disk.

It’s OK to create as many folders within your “Working Documents” folder as
you need to keep a manageable arrangement. You might have, for example, a
different folder for each project you work on.
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Take out a new disk and label it “Travelling Disk”. This is the disk that you will
use to carry your updated files to your other Mac.

Create a folder on your new disk. Give it a name like “Travelling Documents”,
which shows that it contains the files that travel from one Mac to the other.

Set up a Synchronize! X Plus document which identifies the folder on your hard
disk and your “Travelling Disk” as “clones*”, or folders which are to be made
identical.

Check the “Reopen at startup” box in the document. Save it on your hard disk.

* In biology, a clone is an exact biological duplicate. Two people who are
clones have the same fingerprint. The idea here is that Synchronize! X
Plus will always keep these two folders identical, so that when you make
a change to a file in one folder, the newer file will replace the file in the
corresponding folder.

At home, create a similar “Working Documents” folder on your hard disk.
Create a Synchronize! X Plus document which identifies the “Working
Documents” folder on your Mac at home, and the “Travelling Documents” folder
on your removable disk. Check the “Reopen at startup” box in the document,
and save it on your hard disk at home.

Important! Make sure that the clocks on all Macs on which you use Synchronize! X
Plus are set accurately!

It’s critical to Synchronize! X Plus’s proper operation that the time of the clock on
your Mac is set correctly, since it is used to stamp the time your files are changed.
Use the “Date & Time” Control Panel to check the time of your Mac’s clock. The
time does not need to be accurate to the second, since you won’t be changing
files on more than one Mac at a time, but it should be accurate within five
minutes.

Your setup is complete. Now you’re ready to put Synchronize! X Plus to work.

Putting Synchronize! X Plus to work

Since Synchronize! X Plus compares the files in your “Working Documents”
folder with the files in your “Travelling Documents” folder and copies the
newest file to the other folder, run Synchronize! X Plus whenever you make
changes to any of your working documents.

It’s often easiest to run Synchronize! X Plus every day just before you go home,
as a routine part of leaving for the day, so that any documents you may have
changed during the day are copied to your “Travelling Disk”.

When you’re ready to use your Mac at home, run Synchronize! X Plus before you
start working. Any documents which have been changed at work are on your
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“Travelling Disk”; Synchronize! X Plus copies them to your "Working
Documents" folder on your hard disk at home.

When you’re finished making changes at home, run Synchronize! X Plus again
before you shut down your Mac, and run Synchronize! X Plus at work when you
arrive. Synchronize! X Plus copies any documents you changed at home to your
“Travelling Disk” and then to your Mac at work.

You’ve completed the cycle, always taking your working documents with you.
You didn’t have to compare the dates of your documents and drag the newest
ones to a removable disk, or copy an entire folder from your Mac to a removable
disk.

Synchronize! X Plus copies the files for you, and since it copies only the newest
ones, you spend as little time as possible keeping your files with you!

An added benefit of using Synchronize! X Plus is that you also always have a
backup of your most recently changes files, which are the ones least likely to be
backed up!

Using Synchronize! X Plus with a direct connection

If you have a way of connecting your Macs together so that the disks of both
Macs appear on your desktop, you can use Synchronize! X Plus without a
removable disk. There are several ways to do this, including using File Sharing
and AppleTalk or Apple Remote Access, or using “SCSI Disk Mode” for a direct
connection to the hard disk in some PowerBooks.

In this case, you need only one Synchronize! X Plus document. Choose a folder
on each Mac in the document, and save it. Whenever you make changes to your
documents, connect your Macs together and use Synchronize! X Plus to
synchronize your files.

If you use File Sharing and/or Apple Remote Access, Synchronize! X Plus can
make the connection to your remote Mac automatically. Please see the
description of the “Auto-Connect” option in the “Synchronize! X Plus Reference”
chapter.

How Synchronize! X Plus works

Synchronize! X Plus works by looking through the two folders identified in a
Synchronize! X Plus setup document, creating pairs of files and folders which
correspond to each other.
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This is a diagram of corresponding folders:

Working Documents

Personal

Proposals

Projects

Traveling Documents

Personal

Proposals

Projects
Corresponding Folders

Corresponding Folders

Corresponding folders

Each folder pair has the same name, except for the top-level folders, without
regard to capitalization. Each pair is also nested within the same folders on both
sides; for example, the two “Projects” folders correspond, but neither of them
could correspond with a “Projects” folder within the “Personal” folder.

The files in each folder pair are compared by name, without regard to
capitalization, to find file pairs. Each file pair is compared to determine if they
are the same; if they were last changed at exactly the same time (to the second),
they are considered to be identical.

If they are not the same, Synchronize! X Plus copies the newer file to replace the
older file.

Advanced Features

Synchronize! X Plus has a number of advanced features that make it more useful.
These features appear under the Options menu.

For example, it is possible to set up synchronization to occur when disks are
inserted, when a setup document is opened, at login, or periodically at a
particular time of day.

It is possible to connect to a file server or another Mac with File Sharing,
automatically supplying the password even if you aren’t present.

Synchronize! X Plus can recognize when you make changes to two different
versions of a document, warn you, and take appropriate action.

Finally, it’s possible for Synchronize! X Plus to automatically unmount or eject
the disk, completely automating file synchronization. If your Mac has the
capability, Synchronize! X Plus can shut down your Mac when it’s done.
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With these features, you can automatically synchronize in the middle of the night
when you aren’t using your Mac.

Or you can synchronize your files at the end of the day by inserting your backup
ZIP disk or connecting your FireWire disk, making a backup of the day’s work
while you go home.

For more information on these features, please see the description of the Options
menu in the “Synchronize! X Plus Reference” chapter.
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Tutorial

The following tutorial covers the steps needed to set up Synchronize! X Plus to
backup your personal data to another local hard disk. This procedure gives you a
backup copy of your personal data, so that if your main hard disk fails, you can
restore that data to the replacement hard disk, just as it was as of the last backup.

Make sure your Mac knows what time it is

Make sure that the clock on your Mac is set correctly!

It’s critical to Synchronize! X Plus’s proper operation that the time on your Mac is
set correctly, since it is used to stamp the time your files are changed. Use Date
and Time in the System Preferences to check the time of your Mac’s clock. The
time does not need to be accurate to the second, but it should be accurate within
five minutes.

Open Synchronize! X Plus

Double-click the Synchronize! X Plus application icon to open the application.
The icon looks like this:

Synchronize! X Plus application icon

Setting up

Synchronize! X Plus setup documents describe two folders or disks which are to
be synchronized or backed up.

New document window
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To set up a backup of your personal data, follow these steps:

1. Close any open Untitled window.

2. Use the File menu to choose “New”.

3. Click on “Backup”.

4. Click OK.

5. Click the icon for “Folder A”. Use the dialog to choose your Home
folder. An easy way to find it is to choose “Home” from the popup
menu.

Tip: You can also drag the icon for your Home folder over the folder
icon and release the mouse.

6. Click the icon for “Folder B”. Use the dialog to choose the destination
folder. This will probably be on another disk, or perhaps on another
computer.

7. If you didn’t use the “Backup” option when you chose “New”, or you
are changing an existing setup, make sure the following options are set:

a. The “Master” box under the disk to be backed up must be checked.

b. The “Show files to copy” box is not checked. This is optional. When this
box is checked, you see a list of files to be copied. This list can be
examined and selected files can be removed from the list before copying
is started, but copying does not proceed automatically.

Save the settings

Once you’ve set up your document, it’s important to save it so that you can use it
again. To save your document:

1. Use the File menu to choose “Save As…”.

2. Name your document, for example, “Home Folder Backup”.

Your document can be saved anywhere.

3. Click the Save button.

Starting manually

Every time you click the “Sync…” button, Synchronize! X Plus checks the
contents of the two folders shown in the document. When it encounters a file
which is newer than the corresponding file, or which doesn’t have a
corresponding file, it marks the newer document to be copied to the other folder.

To manually start checking, click the “Sync…” button. The Status window shows
files as they are copied.

Any errors will be shown in a dialog and noted in the Log.
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Five Ways To Use Synchronize! X Plus

1. Backup your Home folder to another hard disk.

Synchronize! X Plus will backup your home folder to another hard disk, so that
your files are safe in the event of a failure of your computer ‘s main hard disk.

If your hard disk fails, your personal information is immediately available on the
backup disk.

To set it up, use the File menu to choose New. Click the “Backup” button. Click
OK. Click the folder icons to set your Home folder as the Master, and a similar
folder on another hard disk as the destination.

2. Keep folders on two Macs the same.

This is called “file synchronization”. It is a common use for Synchronize! X Plus.
To set up Synchronize! X Plus for file synchronization, use the File menu to
choose New. Click the “Synchronization” button, then click OK. To choose the
folders to be synchronized, click each folder icon.

When you click the “Sync” button, the two folders are compared and files which
are different will be copied such that the newer file replaces the older file.

3. Back up your personal data to a file server or a removable disk.

Synchronize! X Plus will make a backup of the personal data on your hard disk
to any file server that you can see on your Mac OS X desktop. Synchronize! X
Plus will also backup to a removable disk.

To make an exact backup, use the File menu to choose New. Click the Backup
button, then click OK. Click the folder icons to set the folder to be backed up, and
the destination folder.

Use Start Options (in the Options menu) to “Start copying when document is
opened”. When you’re ready to go home, open the backup document.

As an alternative, use Start Options to set up an automatic backup daily, at a
particular time. Synchronize! X Plus will be automatically opened at the
appropriate time to perform the backup.

4. Distribute files to one or more remote Macs or file servers.

This makes document distribution to other locations easy – just start the
synchronization, and the remote disk will be mounted automatically!
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Since Synchronize! X Plus copies only the information which has changed, your
Remote Access connection need not be in use any longer than necessary, saving
you money in telephone bills.

Synchronize! X Plus will keep the files and the folder organization at the remote
locations identical to your master site if the “Setup type” popup menu is set to
“Backup”.

Use “Auto-Connect” in the Options menu to enter the passwords for the file
server, so that the connection can be made automatically, when you are not
present.

Check “Unmount disk when complete” in the Completion Options to
automatically disconnect when synchronization is complete.

Finally, to completely automate the activity, set a start time and how often the
synchronization should take place in the Start Options.

5. Move files automatically.

Synchronize! X Plus will automatically move files which are older than a preset
number of days to a different disk, or a different Mac on the network.

Use this feature to move older files from an expensive disk array, freeing space
for new files.

To set it up, use the Options menu to check “Move files”. Use “Copy only
files…” in the Options menu to set how old files which are moved must be.
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Tips and Techniques

This chapter describes ways to get more out of Synchronize! X Plus, and how to
simplify its day-to-day use.

Using Synchronize! X Plus automatically

Once you’re familiar with the operation of Synchronize! X Plus, you’ll probably
want to use it with a minimum of fuss. The following tips automate the use of
Synchronize! X Plus and its documents, so that it’s a simple part of your normal
routine.

• Put an alias to Synchronize! X Plus in your Favorites folder. Drag your
Favorites folder in the Dock. When you want to synchronize your files, just
choose Synchronize! X Plus from the folder – click and hold until a menu
appears, find Synchronize! X Plus, and choose it.

• Use the Options menu to choose “Start Options.” Check the “Start
synchronization when document is opened” box to automatically start a
synchronization. Save the setup document (or an alias to it) in your Favorites
folder, and put your Favorites folder in the Dock, so that choosing the item in
the folder automatically starts the synchronization.

• Check the “Reopen at startup” box. When this box is checked, your
document will be automatically opened when Synchronize! X Plus is opened,
and you won’t have to find and open the document manually.

• Don’t check the “Show files to copy” box. This eliminates the window that
allows you to examine the files and/or folders to be copied.

• Use the “Auto-Connect” feature. If you synchronize with an AppleShare
server or File Sharing, use the “Auto-Connect” option to enter your
passwords so that a connection can be made without having to re-enter
them.

Starting syncs with AppleScript

Any sync setup document can be executed with AppleScript.

Here is an example script:

tell application "Synchronize! X Plus"

-- Open a synchronization document

open file "Sync Server"

-- If the Start Option "Start synchronization when the

-- document is opened" is checked,

-- the synchronization will be automatically started.
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-- Start a synchronization

sync file "HardDisk:Sync My Documents"

-- Synchronize! X Plus will automatically open the

-- specified document (if it's not already open)

-- and start its synchronization

-- Quit Synchronize! X Plus

quit

end tell

An AppleScript can also be executed when a sync completes. Please see
Completion Options in the Reference section for more information.

Synchronizing with removable disks

If you carry files between two Macs on removable disks, it’s more convenient to
synchronize automatically when you insert your removable disks.

AutoSync, a small background application, can automatically start a
synchronization when you insert your removable disks. It is installed
automatically by Synchronize! X Plus, and can be installed manually from the
Preferences.

• Use the Options menu to choose Start Options. Check the “When disks
become available” box to start synchronization when you insert your
removable disk. Click OK.

Synchronize! X Plus asks you if you would like a startup application installed
which will automatically open Synchronize! X Plus at the appropriate times.
Click Yes.

Synchronize! X Plus installs AutoSync in your Applications folder. AutoSync
is set to run at login in the Login pane of the System Preferences.

• Choose the “When copying is complete, Quit” option in the Completion
Options. Then set Synchronize! X Plus to run in the background.

• You may want to check one or both of the “Start copying at Login”     and     
“Start copying when disks are available” boxes. This causes the document to
be automatically started when you log in to your computer, and when you
insert the disk.

• Be sure to save your synchronization setup (it doesn’t matter where).

With these options set, Synchronize! X Plus will automatically synchronize your
files when you insert your removable disk. All you have to remember to do is to
take the disk with you!
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Synchronize! X Plus Reference

This chapter describes each of the features of Synchronize! X Plus and how to use
them.

You may find it most helpful to read a portion of this chapter when you have a
particular question, rather than read it all at once.

Synchronize! X Plus Windows

Document Windows

Synchronize! X Plus document windows describe two folders whose contents
will be made identical. You choose the folders that will be compared in a
document window. A document window looks like this:

Document window

Synchronize! X Plus document windows represent the contents of a setup
document. Each setup document contains all the information on a single
synchronization setup. The document window and the Options menu make it
easy to change the settings.

Choosing Folders

To change the folder to be synced, click on the folder icon. Navigate to the folder
you want and click Choose.

Folders can also be set by dragging them into a document window from the
Finder.

Command-click a folder to see the location of that folder on the disk.
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Setup type popup

Use the Setup type popup to conveniently set a synchronization or backup.

Master check box

When the box titled Master is checked, the folder above it is considered a “master
folder”. No files in that folder will be replaced, even by newer files. Any file in
the Master folder which is different from a corresponding file in the other folder,
whether newer or older, will replace the file in the other folder.

This feature makes Synchronize! X Plus copy files in one direction only. This is
useful when you use Synchronize! X Plus to create a backup of your work.

Copy Direction Arrow

The arrow between the two folders in a document indicates which direction files
and folders will be copied or moved.

When the arrow points in both directions, files will be copied in either direction,
depending upon which file is newer. The file which is replaced will always be
the older or nonexistent file. This is the normal setting for file synchronization.

When the arrow points in one direction, files will be copied only in the direction
of the arrow.

The Master check box below a folder identifies the folder as containing files
which are considered “master files”, regardless of age. When a Master box is
checked, files will be copied in the direction of the arrow only, replacing corresponding
files which are newer     or     older.

When Move files  in the Options menu is checked, the word “MOVE” will appear
above the arrow. This indicates that the files will be moved to the destination
folder, not duplicated.

Show files to copy

When “Show files to copy” is checked, Synchronize! X Plus shows you what files
will be copied. When it is not checked, Synchronize! X Plus starts copying
without requiring you to dismiss a dialog box.

Reopen at startup

To cause your synchronization setup document to be reopened every time
Synchronize! X Plus is opened, check this box.

Synchronize! X Plus saves information on whether a document is to be reopened
at startup only when the document is saved. This means that if you checked the
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box and did not save the document, the document will not be reopened the next
time you open Synchronize! X Plus.

The first time you run Synchronize! X Plus on a different Macintosh, you will
have to manually open any documents which have “Reopen at startup” checked,
so that Synchronize! X Plus knows where they are.

Sync… button

The Sync… button initiates the synchronization of the two folders shown in the
window. If the “Show files to copy” box is checked, a dialog shows the files and
folders which will be copied or deleted. If the box is not checked, copying starts
immediately.

When you click the Sync button of a document window and “Show files to copy”
is checked, Synchronize! X Plus shows what files and folders need to be copied
and deleted in a window like this:

Files to copy window

This dialog shows what actions Synchronize! X Plus must take, in what order, to
make the folders identical. Files and folders may need to be copied or deleted,
depending upon the option settings.

To see how many files are to be copied in a particular folder, click on that folder.
To open or close the folder and all folders below it, click on the triangle to the left
of the folder.
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Icons are used to show the different actions to be taken during the
synchronization. The descriptions which follow refer to the actions in the “Files
to copy” dialog illustration above.

1. The folder “Personal” will be created in its appropriate place within the
folder “Travelling Documents”.

2. The file “Letter to Mom” will be copied to the folder named “Personal”.

3. The folder “Temporary Stuff” will be deleted.

4. The file “Proposal (DRAFT)” will be deleted.

5. The file “Flight Confirmation” will be copied to the folder named
“Trips”.

Note that when a file is selected, the modification dates for the file and its
corresponding file, if one exists, will be shown below, as well as the
difference in time between the modification of the two files.

“Trash Can” button

The “Trash Can” button causes any selected files to be marked for deletion. Once
the synchronization is started, the files will be deleted with no further warning.

The effect of this button can be reversed by double-clicking the same files, or by
removing them from the list.

Remove from list

The “Remove from list” button removes any selected actions from the list. Use
“Remove from list” to manually tell Synchronize! X Plus not to copy, move, or
delete a particular file or folder.

Sometimes removing an action from the list requires that other actions also must
be removed. For example, removing a folder to be created from the list requires
that any files to be copied into that folder must also be removed. When such
situations arise, Synchronize! X Plus will warn you and ask whether you want to
remove all affected items.

Reversing copying direction

Sometimes you may discover that a file which is to be copied should not replace
an older version of the file. To reverse the direction the file will be copied,
double-click the file.

When an older file will replace a newer file, the arrow will look like this:   

To reverse the direction again, double-click the file again.
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Cancel

The Cancel button cancels the actions shown in the dialog. When you click
Cancel, no files or folders are copied or deleted.

Start

The Start button initiates the copying actions shown. If no other copying is in
progress, copying will start immediately. If other copying is in progress, the
synchronization will be placed in the Waiting List until the other copying is
complete.

Status Window

The Status window shows the status of the most recent copy operation. When
copying is active, the Status window shows how far the copying has proceeded
toward completion. This is what the Status window looks like:

Status Window

Stop

The Stop button stops copying. Normally, when copying is stopped, a file which
has been partly copied will not be affected. However, if there is very little free
space on the disk, a partially-copied file may be deleted from its destination
without being replaced. Any deleted file is always the file to be replaced.

Pressing the command and period keys at the same time when the Status
window is active has the same effect as clicking the Stop button.
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Continue

The Continue button resumes copying which has been paused. Pausing has no
detrimental effect on the completion of the synchronization.

Pause

The Pause button temporarily suspends copying. Use the Pause button when you
want access to your Mac without the background activity of copying.

Pause is useful when you’ve thought of one small thing you wanted to do before
you leave.

Waiting List Window

The Waiting List window shows a list of all documents whose synchronization is
waiting to be started. This is what the Waiting List window looks like:

Waiting List Window

Use the Waiting List window to monitor multiple synchronizations which are
waiting to be started. Double-click on a document name to bring that document’s
window to the front. Command-click a document to see the location of that
document on the disk.

Remove from list

Use the “Remove from list” button to cancel a waiting synchronization
operation. Select the operation to be cancelled before clicking the button.
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Up and Down Buttons

Use the Up and Down buttons to change the order of the list. The first item (the
one at the top) will always be the next one to start.

The Waiting List is useful for starting several synchronizations when it will take
some time for them to complete. If the “Show files to copy” box is not checked
for these synchronizations, they will proceed as soon as the current
synchronization is complete.

Log Window

The Log window shows the contents of the log. The date, time, and results of
each synchronization are normally stored in the log.

Position the Log window conveniently; its position will be remembered.

To select portions of the text in the Log window, click on the text and drag. The
selected text is highlighted. To copy the selected text, choose Copy from the Edit
menu.

Selected text in the Log can be dragged directly to another application.

Use the Log pane in the Preferences to affect the way the log is displayed.
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Synchronize! X Plus Menus

This section describes the menus in Synchronize! X Plus and how to use them.

Synchronize! X Plus Menu

Preferences

Choose Preferences to show the Preferences window.

The Preferences window has many panes. Choose a pane with the popup menu
or with the right and left arrows.

Settings in the Preferences window apply to all Synchronize! X Plus documents.

General Preferences Pane

General Preferences Pane

Don’t open an Untitled window at startup

Check this box to avoid opening a new Untitled window every time you open
Synchronize! X Plus.

When copying is complete, play

Check this box to play a sound when copying completes. When this box is not
checked, no sound is played.
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Use the popup menu to choose the sound that will be played. If the sound shown
in the popup menu is gray, the chosen sound is not available, and you should
choose a different sound.

Don’t show ‘no files to copy’ dialog

Check this box to skip showing the dialog box that says, “There are no files to
copy”. This is a convenience for those who prefer not to have to dismiss the
informational dialog.

Warnings Preferences Pane

Warnings Preferences pane

Settings in the Warnings Preferences pane establish criteria for warnings issued
about potential problems, such as replacing all one’s files. Such a problem can
occur when a backup is done in the wrong direction, for example.

Warn me if more than 50 percent of the data will be deleted

Check this box to show a warning before deleting more than a certain fraction of
the total data in the top-level folder.

Warn me if more than 50 percent of the files will be deleted

Check this box to show a warning before deleting more than a certain fraction of
all files in the top-level folder.

Warn me if more than 50 percent of the files will be replaced
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Check this box to show a warning before replacing more than a certain fraction
of the total data in the top-level folder.

Always warn for automatic syncs
Cancel automatic syncs after warning for 1 minute
Don’t warn for automatic syncs

Use these settings to determine what happens when an automatic sync occurs.
Automatic syncs occur on a scheduled basis, when a disk is made available, or at
login. To set syncs to run automatically, use the Options menu to choose Start
Options.

Disk Errors Pane

Disk Errors Preferences pane

Settings in the Disk Errors Preferences pane affect the handling of errors which
occur while trying to find the disks for a synchronization.

To announce an error and wait for user interaction, click Wait forever.

To continue with other synchronizations if a disk can't be found, click If a disk
isn't available, Cancel . Set the number of minutes you want a dialog to announce
the error before being automatically dismissed.

File server disks that aren’t available when the sync is started can be mounted
automatically using the Auto-Connect options.
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File Errors Pane

File Errors Preferences pane

Settings in the File Errors Preferences pane affect the handling of errors which
occur while copying files.

Wait forever

Click this button to cause Synchronize! X Plus to show any errors in a dialog box
until it is dismissed.

Skip immediately and log the error

Click this button to cause Synchronize! X Plus skip the file for which the error
occurred and proceed to copy the next file. Errors are always entered in the Log.

Retry, Skip, or Cancel

Click these buttons for the action you want performed after a particular time.

To cause a sync to be cancelled without showing an error dialog, set the number
of minutes to zero.
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AutoSync Preferences Pane

AutoSync Preferences pane

Settings in the AutoSync Preferences pane affect the installation and operation of
the background application AutoSync

AutoSync is a faceless background application which normally runs whenever
the user is logged in. It monitors the current time and the disks that are present.
When a synchronization is supposed to start, AutoSync will launch Synchronize!
X Plus and tell it to start the sync.

If AutoSync is not running, no automatic operations will occur in Synchronize! X
Plus. These operations include starting a sync at a scheduled time, starting a sync
when disks become available, and starting a sync when you log in.

Install AutoSync

Click this button to install AutoSync manually. AutoSync is not installed if the
version currently installed is newer or the same as the version distributed with
Synchronize! X Plus.

To unconditionally re-install the version distributed with Synchronize! X Plus,
click the button while holding down the option key.

Don’t install AutoSync automatically

Check this box to prevent Synchronize! X Plus from asking to install the
background application AutoSync. If this is checked, the only way to install
AutoSync is to click the Install AutoSync button.

Don’t add AutoSync to the login list

Check this box to prevent Synchronize! X Plus from modifying the login startup
list. This is a list of applications that are started when you log in. The applications
are shown in the System Preferences Login pane.
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Normally, when AutoSync is installed, AutoSync is added to the list of login
startup applications, so that automatic operation will occur whenever you log in.
Remember that if AutoSync is not running, automatic operations won’t occur.

Open Synchronize! X Plus in the background

Check this box to open Synchronize! X Plus in the background when it is
launched automatically. This setting will have no effect on Synchronize! X Plus if
it is already running.

Hide Synchronize! X Plus after launch

Check this box to hide Synchronize! X Plus when it is launched automatically.
This causes all of its windows to be hidden, making its operation less intrusive.

Log Preferences Pane

Log Preferences pane

Settings in the Log Preferences dialog box affect how the Log is displayed and
used.

Show Log window at startup

Check this box to show the Log window every time Synchronize! X Plus is
started.

Font

Use the popup menu to choose a font for the text displayed in the Log window.

Size

Use the popup menu to choose the size of the text displayed in the Log window.
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Limit Log file size

Enter the maximum number of lines allowed in the Log file. When the number of
lines in the Log file exceeds this value, the oldest entries in the Log file are
removed.

The range for this number is 32 to 4096. The larger the log file, the longer it will
take to open the Log at startup.

Don’t save anything in the log

Check this box to prevent any information from being saved in the Log.

File Menu

Use the File menu to create and save Synchronize! X Plus documents.

New

Use New to create a new setup document. A Synchronize! X Plus setup
document contains the information describing two folders to be synchronized.

Open

Use Open to open an existing setup document. When a setup document is
opened, a window appears to show the contents of the document.

Close

Use Close to close the active window. Windows generally show the contents of a
setup document. Status, Waiting List, and Log are windows which are always
present, although they are not always visible. Closing a window dismisses it and
makes it disappear.

Save

Use Save to store the contents of a window in its setup document. Synchronize! X
Plus setup documents contain all the settings for synchronizing two folders.

Save As…

Use Save As… to store the contents of a window in a different document which
you name.



Synchronize! X Plus Reference 29

Revert

Use Revert to discard any changes you have made to a document since you last
saved it. Revert is useful when you try some different settings and decide that
you liked it better the way it was.

Page Setup…

Use Page Setup… to set preferences regarding how pages will be printed. This
only affects printing of the log.

Print…

Use Print… to print the Log.

Quit

Use Quit to exit the application. If copying is still underway when you quit, you
will be asked if you really want to quit. While the dialog is shown, copying
continues. If you leave your Mac alone until copying completes, Synchronize! X
Plus will quit when it is done.

Edit Menu

Undo, Cut, Copy, Paste, and Clear

Undo, Cut, Copy, and Paste functions are available for editing text in dialogs and
for copying the selected contents of the Log.

Any changes made to a document since the last time it was opened or saved may
be undone by choosing Revert from the File menu.

Options Menu

The Options menu contains many ways of affecting how two folders are
synchronized. All items displayed in the Options menu apply to the active
window. When the active window changes to a different document window, the
Options menu changes to reflect the options set for that setup document.

When options that affect the operation of the setup document are changed from
their initial settings, a diamond is displayed next to that menu item.

When the active window is not a document window, the Options menu is
disabled.

Auto-Connect…

Auto-Connect allows the user name and password for a file server to be set in
advance, so that the file server disk can be mounted automatically.
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Auto-Connect settings

Automatically connect “G3 Powerbook”

Check this box to automatically mount a file server disk. Enter the user name and
password needed for the file server.

This box is active only for folders which reside on an AppleShare file server, or a
Macintosh running File Sharing.
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Start Options…

Choose Start Options… to set a sync to run automatically.

Start Options settings

Start synchronization at login

Check this box to start synchronization immediately when you log in. The
document will be opened and the sync started at login. The background
application AutoSync must be set to open at login for this option to be functional.

Start synchronization when this document is opened

Check this box to start synchronization immediately when the document is
opened. This works the same as if you clicked the Sync button when you open
the document.

Use this option to automatically synchronize your files by double-clicking the
document.
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Start synchronization when disks become available

Check this box to start synchronization when both disks needed for a
synchronization become available.

When both disks are available, the setup document will be opened, and
synchronization will begin.

A common use for this feature is to automatically start synchronization to a
floppy disk when it is inserted.

To start synchronization with this feature, the background application AutoSync
must be running before both disks become available. In order to take full
advantage of this feature, it is recommended AutoSync be set to open at login.

Start synchronization at a preset time

Check the “On Sunday…” box to start synchronization at a particular time. To
set the time, click the time and use the up and down arrows, or type.

This option is effective only when Synchronize! X Plus is running before the
synchronization is set to start.

Start again every…

Check this box to start synchronization periodically. Enter the amount of time
between synchronizations. Use the popup menu to set the time in minutes,
hours, days, weeks, months or years.

Each time a synchronization is completed, the start time is reset.

Start only on...

Check this box to start synchronization only on certain days. Use the popup
menu to choose which days synchronization will be started.

Don't Start button

Click this button to set a period of time during which synchronizations will not
be started. This is often used to create a "window" of time during which a backup
is not performed.

AutoSync

When you click the “OK” button with synchronization set to occur at login, at a
preset time, or when disks are available, you are asked if you would like
AutoSync, a background application, to be installed.
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AutoSync checks for conditions which you have set for starting synchronization,
and automatically launches Synchronize! X Plus when those conditions are met.

Completion Options…

Choose Completion Options… to set actions to be taken when a sync completes.

Completion Options settings

When copying is complete:

Check this box to perform one of the actions shown when copying is complete.
Only one action can be chosen at a time.

Close this document

Click this radio button to close the document when copying is complete.

Quit

Click this radio button to quit when copying is complete. Note that Synchronize!
X Plus will not quit until all copying is complete, even if the document
containing this option is the first one started.
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Unmount “G3 Powerbook” when complete

Check these boxes to unmount or eject a disk when copying is complete. When a
disk is ejected or unmounted, the action is equivalent to dragging the disk to the
trash.

The disk containing the active System cannot be unmounted.

A hard disk or removable disk containing one or more open files cannot be
unmounted.

Open the file

Check this box to open a file when copying is complete. Click the Choose…
button to choose the file to be opened. This is useful for causing some other
action to occur after a synchronization, including the execution of an
AppleScript.

The file which is opened can be any file on your Mac, including another
synchronization setup document, any alias or an AppleScript saved as an
application. This allows another synchronization to be started or an AppleScript
to be executed when a synchronization is complete.

Conflicts…

Use the Conflicts… option to set the handling of file conflicts. Conflicts settings
do not apply to backups.

There are two types of file conflicts:

• Editing Conflict . Both files have been changed since the last synchronization.
Overwriting the older file in this situation causes the changes made to it to be
lost.

An editing conflict is noted with this symbol: 

• Name Conflict . Two files have the same name, but have different types. An
example of such a situation might be two files called “Proposal”, one of which
was created by a word processing application, and another which was created by
a spreadsheet application. The two files are obviously different, and should not
overwrite each other.

A name conflict is noted with this symbol: 
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Conflicts… settings

Don't check for conflicts

Check this box to turn off conflict checking. When this box is checked, less disk
space and less memory is required. Synchronization will also take less time.

Alert Me

When this box is checked, a conflict will be announced with a dialog box.

Don’t copy either file

Click this button to avoid copying conflicting files.

Overwrite the older file

Click this button to overwrite the older file. This is the same action taken when
conflict checking is turned off.

Move the older file to the Conflicts Folder

Click this button to move the older conflicting file to a special Conflicts Folder.
This folder is located immediately within the top-level folder containing the
conflicting file. If a Conflicts Folder does not exist, it will be created.
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After the conflicting file is moved, the newer version of the file will be copied to
replace it.

Copy only files…

Copy only files… settings

“Copy only files” restricts the files which are copied. Only files which meet the
criteria will be copied. Other files which do not meet the criteria are ignored by
Synchronize! X Plus.

If no boxes are checked in this dialog, all files in all folders are copied.

“Whose names” check box

Use this check box to copy files by matching their names. Enter the portion of the
name which is to be matched. Use the popup menu to choose the kind of
matching. Matches can be made with the first part of the name (starts with), the
last part of the name (ends with), the whole name (matches), a part of the name
(contains), or from a list of file names (are in the list).

 “Which were modified” check box

This check box restricts files by how old they are, or by the time they were last
changed. Use this check box to copy files which are older, or newer by a certain
time, or some particular date.

 “Which are applications” check box

Use this check box to copy only those files which are applications, like
Synchronize! X Plus, a word processor, or a spreadsheet. Documents are not
copied if this is the only box checked.
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“Which are aliases” check box

Use this check box to copy only those files which are aliases.

Don't copy any files…

Choose “Don't copy any files…” to choose files which are not to be copied. A
dialog box is presented which is identical to the “Copy only files…” dialog box
described above. This dialog box, however, describes files which will      not     be
copied.

Well, you ask, what happens if I tell it to copy a file, and also tell it not to copy a
file? It won’t be copied.

Synchronize! X Plus first includes all files which meet the criteria in the “Copy
only files” dialog, then excludes those which meet the criteria in the “Don't copy
files” dialog.

If no boxes are checked in this dialog, no files are ignored.

Copy only folders…

Use “Copy only folders…” to limit a synchronization to a subset of folders.

This option is useful for synchronizing only certain folders on a hard disk.
Criteria for folders include full or partial folder name, inclusion in a list, and
whether the folder is invisible.

Copy only folders… settings

 “Which are in the list” check box

Use this check box to copy the contents of specific folders. Click Add… to add a
folder to the list. Click Add Name to add a folder by name without having to
find it on disk.

To remove a folder from the list, select the folder and click the Remove button.
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Any number of folders may be included in the list. Only those folders that
actually reside within the top-level folders shown in the sync setup will be
copied.

Don’t copy any folders…

Use “Don’t copy folders…” to exclude certain folders from a synchronization.

This option is useful for synchronizing several folders on a hard disk without
synchronizing them all. For example, you might want to synchronize all folders
on your disk except the System folder and the Applications folder.

Use this option to identify folders whose contents are not to be synchronized, in
a manner similar to that shown in “Copy only folders…” above.

Comparing files

This option provides alternatives to the default method of comparing files for
synchronization or backup.

Comparing files… settings

Copy files if modification time is different

This is the normal setting. This setting compares the time that a file was modified
and copies all files which have different modification times.

Copy files if modification time is not an exact multiple of one hour

Use this setting to synchronize or backup files whose modification dates may
have been changed due to a change in Daylight Savings Time or time zone.

Copy files if modification time difference is > 5 seconds

Use this setting to cause files whose modification times are different by a certain
number of seconds to be considered the same.
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Normally, files whose modification times are different at all are copied by
Synchronize! X Plus. This works well for file servers which store and report
modification times in seconds.

Some file servers, however, either do not store file modification times to the
second, or do not report the modification time precisely. This option allows the
flexibility needed for these circumstances.

If files which were just copied are subsequently reported to be different, show
the files to be copied and click on a pair of files in the Files To Copy window. The
time difference between the files is shown in at the bottom of the window. Set the
number of seconds for this option to be a little greater than the maximum
difference observed.

One instance in which this option is needed is when connecting to some
Windows file servers which store the file modification date to the nearest two
seconds. In this instance, the number of seconds should be 1.

Move files

Use “Move files” to move files, rather than copy them. Use this feature to extract
certain files from a larger set. For example, all word processing documents last
modified more than two months ago could be moved to a floppy disk for
storage.

When files are moved to another folder on the same disk, they are moved very
quickly. When files are moved to another disk, they are copied completely, then
the original file is deleted.

Copy existing files only

Check “Copy existing files only” to synchronize only those files which have an
existing corresponding file in the other folder. Any file which does not have a
corresponding file already in existence will be ignored.

This option is not active when a Master box is checked.

Don’t copy empty folders

When “Don’t copy empty folders” is checked, any folders which would normally
be created, and which will be empty when the synchronization is completed, will
not be copied.

This option is useful when copying or moving only certain files. With this option
checked, only those folders which will contain files will be created.
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Sync deleted files

When “Sync deleted files” is checked, any files which are deleted from one folder
will cause the corresponding file to be deleted at the next synchronization.

Check this option to make it easier to delete files from two synchronized folders;
when this option is not checked, a file which is deleted from one folder, or
dragged to the Trash, will be replaced by a copy of the file from the other folder.

With this option checked, when a file is no longer needed, just drag it to the
Trash. Its corresponding file will be deleted during the next synchronization.

This option is not available if “Don’t check for conflicts” is checked in the
“Conflicts…” settings.

Windows menu

The Windows menu shows all open windows. When you open sync setup
documents, they are added to the Windows menu.

Use the Windows menu to show a particular window. Notice that the Waiting
List, Status and Log windows are always present in the Windows menu. These
windows are always available, although they may not be visible.

For more information about the Waiting List, Status, Log and Help windows, see
the section “Synchronize! X Plus Windows”, above.

The Windows menu is particularly useful when many Synchronize! X Plus setup
documents are open at the same time. Use it to show the window for a particular
setup document.

The check mark in the Windows menu shows which window is active. If no
windows are active, no check mark will appear in the menu.
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Requirements

Synchronize! X Plus is designed to work effectively on all Macintosh computers
running Mac OS X.

Synchronize! X Plus supports AppleScript. For more information on AppleScript
support, see the Tips and Techniques section in this manual.

Synchronize! X Plus documents vary in their requirements for disk space. When
large disks are synchronized with conflict checking turned on, disk space
requirements can be substantial.
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Feedback

Synchronize! X Plus can be what you’d like it to be. Make
suggestions and see them incorporated into the product.

Send us your suggestions and feedback via electronic or regular
mail to:

Email

support@qdea.com

U.S. Mail

Qdea

Technical Support

6331 Hilton Court

St. Paul,  MN  55115  USA

Technical Support

Technical Support is available for Synchronize! X Plus via email,
or by letter at the address above. Please allow 48 hours for a
response to email.

Email support@qdea.com

Technical support is also available by telephone:

+1 (651) 779-0640

Answers to common questions about Synchronize! X Plus are
posted on the Qdea web site:

http://www.qdea.com

Upgrades

New versions of Synchronize! X Plus are published periodically
on the Qdea web site. They may also be available on Internet
shareware download sites.

For the latest version, check Qdea’s Web site:

http://www.qdea.com
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Reversing copying direction, 21
Revert, 32
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S
Save, 31
Save As, 11, 31
Setup type popup, 18
Show files to copy, 19
Show Log window at startup, 30
Skip, 28
Skip immediately and log the error, 28
Start, 21
Start again every…, 35
Start All, 32
Start only on certain days, 35
Start Options, 34
Start Options dialog box, 34
Start synchronization at a preset time, 35
Start synchronization at login, 34
Start synchronization when disks become available, 35
Start synchronization when document is opened, 34
Status window, 21
Stop button, 22
Sync deleted files, 43
Sync… button, 19
Synchronize! X Plus menu, 25

T
Technical Support, 45
Triangle icons, 37

U
Undo, 32
Unmount disk, 37
Up button, 23
Upgrades, 45

W
Wait forever, 28
Waiting List window, 22
Warnings Preferences, 26
When copying is complete, play, 25
When copying is complete:, 36
Windows menu, 43
Windows, description of, 17


